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Welcome to the latest edition of my monthly Final Cut Studio newsletter for March, 2010.

The goal of this newsletter is to provide information helpful to the interested user of 
Final Cut Pro. This newsletter publishes each month, past issues are available in my 
store. All software references are to Final Cut Studio 3 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find 
daily tips, the latest industry news, and over 550 articles and tutorials to help you get 
the most out of Final Cut!

And, if you haven't already, please subsubcribe to this free monthly newsletter here. 

We are getting our social media act together! Follow us online:

�●     Larry on Facebook
�●     Larry on Twitter
�●     Latest Industry News
�●     Larry Jordan's Blog 

NEWSLETTER CONTENTS
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�●     Digital Production Buzz Named Official Podcast for the 2010 NAB Show
�●     Crisis du Jour: What's Happening to Final Cut?
�●     Commentary: A Plea for Better Metadata Support 
�●     Embedding Metadata in H.264 Video
�●     Review: Data Robotics' Drobo S 
�●     More Free Stuff -- Over 100 Articles Posted This Month Into The Editing Library

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/
http://www.larryjordan.biz/newsletter
http://www.facebook.com/pages/Larry-Jordan/174158732452
http://twitter.com/LarryJordanFCP
http://www.digitalproductionbuzz.com/news.php?newsid=0
http://www.larryjordan.biz/blog


�●     Thinking About Storage -- Why Don't Hard Disks Hold as Much as They Say?
�●     Larry's Blog: Resolving a Problem with the Latest ProAps Update 
�●     How You Connect Your Drive Determines It's Speed
�●     Check-out My Latest Video Tutorials
�●     Audio Gear For The Digital Production Buzz At NAB
�●     Naked Mice Need Nice Rugs

PASSING THOUGHTS

�●     Favorite iPhone Apps
�●     New Website For Young Filmmakers
�●     New On KenStone.Net
�●     Getting QuickTime to Play Video at 4x Speed
�●     Fixing Sync Drift in Audio-Only Clips
�●     Shooting DSLR Video
�●     Bad Fonts
�●     2nd Monitor Problems
�●     Sending Comments To Apple

READER MAIL

�●     Getting Organized
�●     Mixing Hard Disks
�●     Creating a PAL DVD
�●     Creating MPEG Files For DVD
�●     Where Do You Drag What?
�●     Importing Text Into Motion
�●     Displaying 16:9 Video as 4:3
�●     Canon DSLR Questions
�●     Deconstructing Sequences
�●     Working With Multicam
�●     Setting Field Dominance
�●     What Is "Enough" RAM?
�●     Creating Closed-Caption Video
�●     How Do You Capture A Game?

WRAP-UP

WELCOME

As you are about to read, we are delighted to announce that the Digital 
Production Buzz has been appointed the official podcast for the 2010 
NAB Show! This is our second year working with NAB and we are 
really excited.

More on that in a minute.

In addition to gearing up (literally) for NAB, we have wrapped our latest 
PowerUP seminar tour. I want to say thank you to the hundreds of 
editors that attended our seminars, as well as acknowledge the support 
of Red Giant Software and Smartsound. In talking with many of you, I 

am already sensing that 2010 is shaping up to be a better year than 2009. (Which is good, 'cause I 
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can't think of a year that was worse...) 

We are already working on some new training ideas for the spring. I'll share those with you in the 
April newsletter.

Finally, to the hundreds of people that take the time to write and share their thoughts on this 
newsletter every month, I am truly thankful. Your contributions are what make this newsletter so 
exciting to read each month.

And, thinking about exciting...!

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ NAMED OFFICIAL PODCAST FOR THE 
2010 NAB SHOW

NAB made it official last week: they've named the Digital Production 
Buzz their official podcast for the NAB SHOW 2010! This is the 
second year in a row we've won this honor and this year, based on what 
we learned last year, we are planning to do even more.

Here's the press release from NAB (1.1 MB PDF).

Thanks go to our incredible producer for The Buzz- Cirina Catania - for 
her tireless work in making this possible!

WHAT WE ARE DOING

Starting Saturday, April 10, we will post a one-hour NAB Show Special Report every evening during 
NAB featuring interviews with industry leaders covering the latest news from NAB. News you need to 
know. At this point, we plan to create a new one-hour Special Report every day from Saturday till 
Friday.

Then, starting Monday, April 12, we will supplement our one-hour NAB reports with hourly 
newscasts. These NAB Show News Briefs are five minute reports providing hourly updates from the 
show floor covering what's new, what's hot, and what can't wait until the evening. These News Briefs 
start at 9 AM and run hourly until 5 PM.

WHERE YOU CAN GO TO HEAR ALL THIS

In addition to providing all The BuZZ Special Reports on iTunes and 
our website, you can visit www.nabshowbuzz.com. This provides a 
listing of all the latest newscasts, plus details on who is profiled in 
every NAB Show Special Report. Everything you need -- all in one 
place. 

Plus, this year, we've put together a free Flash Player that you can add to your website. This is a 
cool way to build traffic to your site and stay current with NAB -- all at the same time. Click here for 
the simple installation instructions.

WHAT GEAR ARE WE USING?
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I thought you might be interested in learning about the gear we are using to cover NAB, so I've 
written an article about this. Although it occurs later in this issue, you can view it here.

I also want to thank our sponsors:

�●     Adobe Systems -- Newscasts 
�●     Data Robotics -- Special Reports 
�●     Focal Press -- Special Reports 
�●     Pond 5 -- Special Reports 
�●     Carl Zeiss Photo Division -- Special Reports 

Their support makes our coverage possible and I'm very grateful. Please take a moment to check 
out their websites.

WE CAN USE YOUR HELP

We are creating a team of reporters and editors, but we still need a few more. If you are coming to 
NAB and want to help out for a day, send Debbie Price, our event manager, an email. We'll provide 
all necessary gear, along with a free pass to the entire NAB Show floor.

This is one of those projects that the closer it gets, the 
bigger it looks. But we had a great time last year, and 
I'm looking forward to covering it again this year. I'd love 
to see you there -- South Hall - Lower Level - Booth 
8826. (We're right next to the Post Pit!)

[ Go to Top. ] 

CRISIS du JOUR: WHAT'S HAPPENING TO FINAL CUT?

You know the drill. Someone at Apple coughs and suddenly the rumor mill is filled with frenzied 
statements that the doom of Final Cut Studio is at hand. "The Death of Final Cut" rumors have 
gotten to be as regular as spring floods or a plague of locusts.

Recently two new variations on 
this theme have appeared: 
"Apple hasn't updated Final Cut 
in [fill in number of hours / 
minutes / seconds since last 
release] therefore Apple must be 
killing it!" -- and -- "Final Cut 
doesn't support all the new 
features in Snow Leopard, 
therefore Apple must be killing it!"
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Whisper this loudly in a worried tone at a crowded user group meeting and panic ensues.

People, get a grip.

Apple is in the midst - like many other large developers that start with the letter "A"-- of a very thorny 
technical problem: in order for Final Cut Pro to take advantage of Snow Leopard features, it needs to 
be significantly rewritten. Not just a little; a lot.

I've been told that Adobe took several years to rewrite Photoshop to support the Intel chip. Years! 
Why? Because millions and millions and millions of lines of code needed to change.

The same problem exists with Final Cut Pro. It is a massive application, with tens of millions of lines 
of code needed to be changed. Apple needs to convert it from its old code (Carbon) to new code 
(Cocoa). And this doesn't happen overnight. Not even over a long weekend. 

As Philip Hodgetts wrote in a recent blog:

The rewrite [of Final Cut] to Cocoa, even assuming they don’t make fundamental 
changes [to the features of the software] is very time consuming and a lot of hard 
work to rewrite and test. That there is evidence in the current release of work already 
complete strongly suggests that the team is hard at work doing what’s necessary to 
bring Final Cut Pro into the modern Cocoa OS X code era. But don’t expect to see a 
converted release any time soon. There’s a lot of work that the QuickTime team [also] 
has to do to add functionality to the underlying QTKit API (The modern QuickTime API 
for programmers) that an updated Final Cut Pro needs. Right now there’s no support 
for QuickTime metadata in QTKit, for example.

This means that even without adding new features, Apple has a massive, multi-year, multi-million 
dollar project on its hands. 

However, it is my hope that in addition to bringing Final Cut up to modern day specs, Apple also will 
take the time to add long-needed features to the application. I hope for improved stability, especially 
for longer projects involving thousands of clips, faster and more stable rendering using fetures in 
Snow Leopard, and a totally redesigned media manager providing better archiving options for 
tapeless media. Along with dozens of smaller tweaks that we've talked about endlessly in this 
newsletter. 

Apple probably won't add all the features that all of us want. In many cases, we don't agree among 
ourselves on which features qualify as "most important." 

Personally, I have complete faith that Apple is currently working hard on improving Final Cut Pro 
(and Studio). I see NO evidence they are intending to let it die, or even lapse.

However, they are in the midst of a very large undertaking that will take a while longer to complete. 
For this reason, I don't expect any significant new versions of Final Cut Pro until late this year at the 
earliest. More likely, first quarter next year.

Things may be quiet now at Apple. However, that doesn't mean they are standing still. A delay is not 
the same as death. To me, silence means that Apple is working on it -- but they have a very large 
amount of work to do.

[ Go to Top. ] 
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COMMENTARY: A PLEA FOR BETTER METADATA SUPPORT

As I was writing this issue of the newsletter, I got an email from John Bertram in Toronto that 
included two different missives on why metadata support is crucial to the next generation of Final 
Cut Pro. 

One is a tongue-in-cheek monolog, which can be seen here. But the second was more serious, and 
more thought-provoking. So, I asked John to edit his second, wider-ranging essay into something 
shorter that focuses on metadata, because I wanted to share his commentary with you here.

Here's what John wrote: 

As recently as mid-2008, if you'd asked me to write down my personal "wish list" for 
Final Cut Pro (you know, that pesky list we all have bouncing around in our brains), I 
doubt the following paragraph would have even occurred to me. But today, in early 
2010, I know this one wish would certainly rank at or near the very top: 

Final Cut Pro urgently needs a vastly improved Metadata capability. Ideally this would 
be something very much akin to Aperture's ability to import, create, customize, 
display, and intuitively manipulate a wide range of metadata -- both camera-created 
and user-defined. 

And here's how my Conversion on the Road to Metadata came to pass... 

By the time of Final Cut Studio 3's release in the early Fall of 2009, it happened that 
I'd actually spent more of the preceding year working with Aperture than I had with 
FInal Cut -- and had become so accustomed to Aperture's powerful Metadata & 
Keyword-based sorting, searching, and organizational capabilities, that I began taking 
much of it for granted. 

So much for granted, in fact, that I probably unconsciously just assumed that any new 
version of Final Cut was bound to have incorporated the same functionality. How 
could it not? Especially since both of these Apple applications typically involve 
importing visual media from a host of different cameras, and both frequently require 
accessing, arranging, and referencing hundreds -- if not thousands -- of distinct 
"creative units" at any given time. (In Aperture, those units are of course individual 
image files, represented by Versions; and in Final Cut, individual media files, 
represented as Clips.) 

Most of my previous work in Final Cut had been on shorter, script-oriented projects, 
where all my meticulously-logged Scene, Shot and Take numbers (I've always had to 
be my own assistant editor) made Bin organization and Clip sorting relatively 
straightforward. 

But it also happens that my first major project using version 7 of FCP (really "6.5" -- 
but that's for another rant -- I mean, "article") is a long-form, no-budget indie doc, with 
absolutely no pre-determined scene order, and certainly no script or slates to use as a 
numbering or naming guide. It's just a few thousand clips worth of interviews and B-
roll shot over several months (in both single and two-camera shoots; acquired on 
AVCHD but also HDV) -- all of which is creatively open to being intercut in a thousand 
different ways. 

No problem (I thought)! I'll just organize this project the way I do my images in 
Aperture: I'll use all that good metadata the cameras record (like the Date & Time info 
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for each shot, which will make displaying any group of Clips in simple chronological 
order a breeze), and I'll create new sets of custom Keywords (for location, interview 
subject, weather & light conditions, eyeline direction, which cameraperson, which 
interviewer, needs release form -- and dozens more), which I can then apply to my 
Clips either as I'm logging them, or at any point along the way as I'm editing. 

Oh, and in the Browser -- just like with Aperture's Smart Albums -- I'll simply create 
some Smart Bins, which will automatically include any Clips whose metadata and 
Keyword tags match the criteria I've set. Plus I'll be able to do precise searches, 
simply by checking off the Keyword combination I want -- with whatever "AND", "OR", 
"BUT NOT" qualifiers I choose (plus any further metadata filters such as date range, 
clip length, rating level, camera model, etc.) -- and in a second or two see just the 7 or 
8 clips out of my project's 2-3 thousand whose attributes exactly match the search 
terms I've set. And all with just a few mouse clicks in what I'm sure will be the search 
window's new, easy-to-navigate HUD -- no typing required. 

Yeah -- it'll be great... 

Now, even before bringing my FCS 3 Upgrade box home from the Apple Store, I knew 
that many a "wouldn't it be nice" Final Cut feature gets pulled over at the Carbon/
Cocoa roadblock of Old Code vs. New Code, and that our dear old FCP is apparently 
still burdened by enormous and impenetrable sedimentary layers of the former, BUT...

I'd also been hearing about this glorious age of the "Tapeless Workflow" we've 
apparently entered -- a brave new world where METADATA is king, and where we're 
all supposed to be taking full advantage of it to organize our projects so much faster 
and with such greater ease. So you can imagine my disappointment that Final Cut Pro 
-- even at version 7 -- doesn't appear to have gotten that particular memo.

In fact, compared to a now well-established program like Aperture, Final Cut's abilities 
to ingest and retain, to augment and automate, to customize and configure, to easily 
access, selectively display and effectively utilize most kinds of Metadata -- whether 
directly from the camera; added, edited, or inserted during the Logging process; or 
created, defined and applied within its own Browser -- range from frustratingly limited 
to embarrassingly nonexistent. 

But wouldn't the kind of flexible, intuitive and infinitely customizable sort-ability & 
search-ability described above be a temptingly powerful option for just about any 
editor on any large project? Of course like any feature, no matter how elegant or 
appropriate, it would not get used by every editor, or on every project. Still, if all of 
Aperture's metadata-based organizational power can be applied to individual image 
files (and has been for years now), why can't it also be applied to individual movie files 
(aka clips) in Final Cut Pro? 

Recent insights and musings from technology insider Philip Hodgetts have helped me 
better understand some of the technical, business, and design factors at play here. 
But even though some of this NewCode-requiring functionality may still be as much as 
two long years away for Final Cut, that won't stop me beating the drum for the kind of 
metadata functionality I honestly think (however naively) any professional NLE should 
be able to do right now -- even in the confines of a more rigid, "OS-9 Lives!" interface 
like Final Cut's. Things like... 

1) See, Retain, and MAKE ACCESSIBLE TO THE USER (in easy-to-
customize Views) all camera metadata from ALL ingestible formats, 
whether SD or HD, tape-based or to-the-file born. For example, this 
would include the camera record Date & Time information from even 
Non-TimeCoded formats like HDV and AVCHD. No longer would we 
have the bizarre split-code personality disorder of Final Cut's Log & 
Transfer window being able to see and display the Date created 
information for each about-to-be-ingested-and-transcoded AVCHD clip, 
only to have that same -- and potentially quite valuable -- information 



be invisible and completely inaccessible to the Final Cut Browser -- the 
Browser of the very same application! 

2) Let the USER assign and configure any number of custom-named 
Logging fields (with lots of preset templates to get started) -- with more 
options for auto-repeating text fields, customized combinations of 
selected camera metadata merging with user-generated information, 
and a direct transfer of all that data into corresponding, easily 
searchable Columns in the Browser. 

3) Let the USER create unlimited numbers of custom and always 
searchable Keywords. Keywords in families. Sets of keywords for 
different kinds of projects. Keywords visible in a floating Heads-Up 
Display, in a separate pane, or as buttons in their own visible-whenever-
and-wherever-you-choose Control Bar. Keywords you can easily assign 
to a single clip (whether in the Browser or the Timeline; before 
ingesting or months into the editing); or to a non-contiguous group of 
selected clips; or to an entire Bin's worth of clips -- whatever's 
highlighted, and all in a single mouse click. 

Apple's Aperture app (--and how much fun is that to say!--) does all this, and more, 
with relative ease. And it doesn't ask you to purchase, learn, and then constantly have 
to work with a whole 'nother, multi-user, high-end business program called 
"ApertureServer" to do so. 

So if progress in software development is to be measured in terms of giving the USER 
more choice, more flexibility, and easier access to more information (so those choices 
can be made more intelligently) -- which is exactly how I think it should always be 
measured -- then surely bringing this kind of already-overdue Metadata muscle to 
Final Cut ASAP would be a huge step forward. It's all about giving power to the User, 
not just to the Program. 

Oh dear -- I think I'm getting a little "verklempt". 

Best to end with the paraphrased words of Coffee Talk's Linda Richman (aka Mike 
Myers' classic SNL character): "Talk amongst yourselves. I'll give you a topic: When it 
comes to Metadata, Final Cut Pro is neither final, nor cutting... (nor particularly pro). 
Discuss." 

JOHN BERTRAM is a Toronto-based writer/director/editor who is 
currently busy resenting having to learn anything at all about Codecs 
and Conversions, Renders and Resolutions, Formats and Frame Sizes, 
Gradients and Gamma Curves. He began Non-Linear Editing with Final 
Cut 4, and since then has been struggling to understand anything he 
can about, well... (see list). The preceding article, together with his new 
blog you can read here, will illustrate the futility of that struggle. 

John also sent his original article to Philip Hodgetts who added the following comments:

[First, I need to state that I have no insider information, nor am I passing on rumors. 
This is just my understanding from looking at the software with the eyes of a 
developer and connecting the dots.] 

I guess you do know that FCP does retain all the metadata from non-tape workflows 
ingested via Log and Transfer. But the [Browser] bin code, as it currently is, is not 
flexible. Each column has to be added by Apple (and they have added a lot over the 
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years). Needless to say I expect that is "non-trivial" to change.

But every indication is that Apple have been working on a foundation for metadata 
management in QT Media (as of FCP 5.1.2) and that is exposed in the XML export. 
See our miniME app- in demo mode you can export to an Excel spreadsheet. http://
assistedediting.com/miniME 

These things are, I think, on the road map for FCP but will require large sections of 
the code to not only be ported to Cocoa but also completely rewritten. When you 
rewrite one component it often has unforeseen (or non-obvious to those outside the 
dev team) consequences and implications on other code. Fortunately a lot of FCP 
was written in modular form from the start, Browser included. Check inside the FCP 
package > MacOS > Plugins > Browser.bundle. .bundles usually indicate complied C 
code i.e. Carbon. In fact there were earlier versions of these in all versions of FCP. 
The .bundle version dates from around FCP 4.5 (or perhaps FCP 4.0) when they 
recompiled the Carbon code from CFM (Code Fragment Manager) to MachO (and 
thereby losing OS 9 compatibility).

All these bundles need to be rewritten. Most can probably just be ported as-is without 
significant change to functionality. (Really what improvements to the Transition Editor 
do we need?) In the earlier versions of FCP I experimented with removing specific 
plug-ins and found FCP still ran but the functionality disappeared. 

Anything in the Frameworks folder is Cocoa.

Also, the new code is found in Resources > English.lproj. A .nib file indicates Cocoa, 
so I'm informed: at least created in Xcode's interface builder.

Overall, I'd say John is pretty much spot on as to what I'd like to see in the future 
version of FCP as far as metadata management, but it can't be shoveled into this 
code. It has to be new. I also *hope* that Apple takes this opportunity to rework Media 
Management but I have no data points to suggest whether or not they will, particularly 
now that media management is very much improved from the early days.

Remember too, that the FCP dev team believed up until July 2007 that there would be 
64 bit Carbon (only because Apple said so at the WWDC in 2006 only to reverse it a 
year later). it was only then that the need to rewrite became essential. Ultimately I 
think this is a great thing although it will take time because I'm of the (optimistic) belief 
that Apple will be rewriting things like the browser to give exposure to the metadata 
they're already retaining and tracking. If they could have gone to 64 bit Carbon they 
may not have felt the need.

Which is why I think we'll not see a new version until 2012 as I said in my recent blog 
post.

The reality of code development is that it does not scale. 10 engineers won't be twice 
as fast as five. In fact evidence suggests that it would take longer with 10 than 5 
(whatever the [actual] numbers are). There's an article floating about the "myth of the 
man month" related to software dev scaling. Software development takes the time it 
takes. 

Even so, I'd say it's probably a very expensive rewrite, which FCP can definitely afford 
as the Pro Apps Suite (i.e. FCP really) is highly profitable based on my back-of-the-
envelope calculations.

Good stuff, though, John. Keep the agitation going. 

OTOH, Premiere Pro has awesome metadata tracking and handling and yet the users 
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seem to not care about it one iota! If you're at NAB catch my presentation on 
Wednesday at 1 PM in the PostPit at NAB on "The Mundane and Magic Future of 
Metadata".

The issue of how you find media files when there are tens of thousands to search from becomes 
increasingly important as we move into all tapeless workflows. Adobe has staked out a strong 
position in this area for all their media applications.

It is my hope that Apple is working to bring the metadata power of Final Cut Server down into all of 
its applications, then make it easy enough for mere mortals to use. 

[ Go to Top. ] 

EMBEDDING METADATA IN H.264 VIDEO

William Aleman writes:

Artists and producers are starting to ask for the display of their information (artist's 
name, project details as extended description, "i" short for information, credits among 
others fields) in iTunes and Apple's devices. The problem is that the information 
locally entered in iTunes' tab is not embedded in the files, it's user's iTunes library 
display only. Moving the files to a different server or location will cause the lose of all 
metadata - information about the information- as described by some specialists in this 
field.

I haven't found yet a way to add metadata from FCP 6.0 or Apple Compressor for 
iTunes and Apple's devices while exporting the files, except chapter markers. In 
addition, all locally created music videos automatically get placed by iTunes under 
Movies category. That was until I found the solution through some dedicated software, 
which does just that: to embed this type of metadata in the files wherever they go. 

I found three applications dedicated to embed metadata in video and audio file with 
the purpose of being displayed in applications that support the display of this type of 
data, including chapter markers, as iTunes, QuickTime, among others do.

This applications are MetaX, Lostify, (shareware) and SimpleMovieX (buy). After 
several tries of all three, the best that worked for me is MetaX.

A good feature of MetaX is that you can update the metadata in the files already in 
iTunes (music video, movie or audio) without re-importing them. In addition, we can 
change and embed a poster frame. To update the metadata, we just have to hold 
down 'Control' key in any iTunes' tab, at the bottom of the list of the open window 
where we will find a text line that says "Edit Tag in MetaX" That will load the file from 
iTunes into the MetaX and will update it without leaving iTunes. I haven't tried that 
feature in the other two applications. By the way, any QuickTime movie can be 
metadata embedded with this application, not just the H.264 Codec.

Shareware

�●     MetaX 
�●     Lostify 

http://www.kerstetter.net/index.php/projects/software/metax
http://download.cnet.com/Lostify/3000-2141_4-88408.html


Trial & Buy 

�●     SimpleMovieX 

Larry replies: Thanks, William, for sharing this information.
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REVIEW: DATA ROBOTICS INC. DROBO S 

NOTE: For my policy on reviews and disclosure, click here.

As I was talking with Data Robotics, who is one of our sponsors for our 
NAB coverage, about the gear I wanted to use in our booth for NAB, 
they offered to provide us a loaner unit of their new high-end product: 
DroboElite.

I thought this was a great idea, because this gave me a chance to test 
it under real-world, multi-user conditions. (I'll have a review of it next 
month, after NAB.)

Since they were already loaning us gear, I asked if they could also loan me their new Drobo S for me 
to review. It arrived earlier this week and I've spent some time playing with it.

DROBO BACKGROUND

I first really looked at Drobo in October, 2008, when I reviewed their initial FireWire unit. (They were 
shipping products before that, but since they connected via USB, they were way too slow for any 
editing application.) You can read that review here.

My big gripe was that the Drobo was too noisy and far too slow for any real-time work, though it 
would fit well into on-set capture of tapeless media.

About a year later, Data Robotics shipped the DroboPro, a much faster unit that connected via iSCSI 
and had a quieter fan. You can read my review of the DroboPro here.

Then, earlier this year, they shipped both the Drobo S and, at the high-end of their product line, the 
DroboElite.

While there are a number of features that distinguish Drobo from other products, the key ones, for 
me, are that you can mix and match different sized drives in the same box with no performance 
penalty, and that the storage it contains is easily expandable so it grows as you do. Unlike any other 
RAID, to add more storage you simply swap out a smaller drive for a larger drive and Drobo 
automatically rebuilds everything.

No copying data. No reformatting drives. No down-time. Very, very cool.

FIRST LOOK - DROBO S

The Drobo S fits between the Drobo and the DroboPro in 
the product line.
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The Drobo S arrives nicely packaged, wrapped in a black cloth bag for protection. All shipping 
materials are recyclable. The installation instructions are clear and written with a friendly tone. They 
make you feel like you aren't buying a product, but adopting a friend.

The Drobo S comes with drives uninstalled, so you can add your own drives, or buy them from 
Drobo. The unit holds five drives (compared to four for the Drobo and eight for DroboPro and 
DroboElite).

Drobo recommends using Western Digital drives. If you need performance, they recommend the WD 
Black series. If you need reduced energy consumption with a variable spin rate, they suggestion WD 
Green. In this case, I was sent two 2-TB, and three 1-TB WD Black drives to use for the test. Notice 
that the drives were not all the same size!

Installing a drive is as easy as taking it out of its protective wrapper and sliding it into the Drobo. 
(Remember, these drives are very sensitive to static electricity. Be sure to ground yourself before 
handling a drive.) The drives are keyed, so you can't install them improperly. The front cover is 
magnetically attached, which makes accessing the drives very easy. Each drive is held in place by a 
spring clip, no additional hardware, like screws, is necessary. 



Here's how I loaded the drives into the unit, as displayed in the Drobo Dashboard.

CONNECTING AND SETTING UP THE UNIT

All connections are on the back: 

* Power 
* USB 
* FireWire 800 (2 ports) 
* eSATA

Plus, a rocker switch for power! (The Drobo could only be powered off by pulling the plug.)

As I've explained in other reviews, USB is far too slow for any reasonable video editing, so I 
concentrated on looking at the FireWire and eSATA connections.

NOTE: Later in this issue is a discussion of the various ways of connecting hard 
drives. You can jump there now by clicking here.

For the purpose of this test I bought an eSATA card from LaCie and installed it in Slot 2. My Mac 
reported it had a Link Width of 1x. The test was done on a 2.93 GHz Quad-Core Intel Mac Pro with 8 
GB of RAM. Speed was measured using the same settings on the AJA Speed Test utility. Speed 
varies as settings change, real-world results will vary somewhat from these numbers, but the general 
range should be the same.



Turning on the unit involves momentarily pushing the rocker switch at the back. (Turning off the unit 
requires forcefully holding the rocker switch down for 3-4 seconds, a nice protection again accidently 
turning off the unit.) Power-up took a bit longer than a minute, but there are lots of blinking lights to 
watch, so you won't get bored waiting. 

All Drobos are controlled from the Drobo Dashboard, a software utility that allows you to monitor 
usage, reformat drives, and provide other maintenance functions. Prior to starting the unit, I 
downloaded the latest version of Dashboard from the Drobo website (v.1.6.8) and installed it.

Once the Dashboard was installed, using a standard installer, and the unit was powered up, two 
messages appeared on my screen. The first was from the operating system saying it could not 
recognize the drives, did I want to reformat? The correct answer is Ignore.

The second message was from the Drobo Dashboard asking if I wanted to format the drives. The 
correct answer here is Yes. Be sure to format drives using the Drobo Dashboard, not the OS.



Upon starting the Dashboard, the first question it asks is how big do you want the Drobo to be. This 
is an important question, because it determines the ultimate maximum size of the Drobo when fully 
expanded. In my case, I set this to 8 TB, even though when I format the drives, my total storage 
space will be about half that. By setting the maximum size larger than the drives I have now, this 
allows me to expand my storage in the future by just adding larger drives, without having to transfer 
data back and forth.

NOTE: Once you reach this maximum size, you can still add larger hard disks to the 
unit. At which point, it will create a second hard disk volume and display that on your 
desktop. 

After setting the overall volume size to 8 TB, formatting took about three minutes, and the drive was 
ready to use. (Other RAIDS that I've used have been known to take several hours to format and be 
ready for use. This is why most RAIDS come with drives preinstalled and formatted.)

Here's how the drive space was allocated, once formatting was complete. Note that although I 
installed 7 TB of storage, only 4.53 TB was available. This is normal for RAIDs and I talk about it 
later in this issue - click here.



The Dashboard also allows you to set whether you want the drive configured as, essentially, RAID 5 
or 6; how long until the drive spins down, and whether the front lights are too bright. For my tests, I 
left the drive formatted as single drive redundant (which means that it would recover if one drive 
failed.) This settiing maximizes speed and storage. I also set the spin down time to 2 hours.

NOTE: You don't need to have the Dashboard open to use Drobo. The Dashboard is 
an administrative tool, not needed for normal operation. (However, it has a very cute 
graph, which is fun to look at, even if it doesn't change that often.)

HOW FAST IS IT?

The Drobo S is much, much faster than the Drobo and almost as fast as the DroboPro. It is definitely 
fast enough for editing most video formats, and, depending upon your video format, it is probably 
fast enough for multiclip editing of up to 8 streams.

First, let's measure how fast the unit is. For these initial tests, the Drobo S was totally empty.



When connected via FireWire 800 and with only one other FireWire 800 device connected, write 
speeds averaged 42.4 MB/sec and read speeds averaged 61.8 MB/sec. 

When connected via eSATA, and no other eSATA devices connected, write speeds averaged 67.4 
MB/sec and read speeds averaged 71.3 MB/sec. This is 59% faster for writes and 15% faster for 



reads. The benefit to connecting via eSATA are faster data transfer speeds and no slow-downs 
when other FireWire devices are attached to the computer. However, not all Mac laptops support 
eSATA -- only those that have an ExpressCard/34 slot.

This eSATA speed compares favorably to a G-Technology RAID2 configured as RAID 0. RAID 0 is 
very fast, but provides no data redundancy. As we move more and more into tapeless video, 
protecting your data becomes increasingly crucial. In this test, the G-RAID was about 90% full.



By the way, these speeds are about the same as an internal hard drive on a MacPro. However, with 
an internal drive there's no data redundancy or expandability because you are using a single drive.

TESTING IN THE REAL-WORLD

So, how does it work in the real-world of massive video files and editing?

To test this I copied 952 GB of Final Cut Pro project data to the Drobo - um, yeah, it took about three 
hours.

During the transfer, according to Activity Monitor, the average transfer speed from the G-RAID to the 
Drobo pretty much maxed out at the top end of both devices -- about 83 MB/second.



I played back an existing sequence of XDCAM EX footage - in this example, three layers of video, 
effects, and live action. 

Then, I created a five camera multiclip of DVCPROHD (P2) footage just to see what the Drobo could 
handle. During playback, data rates hovered around 55 MB/sec, with no dropped frames reported by 
FCP.

Cool.

FINAL THOUGHTS

Drobo has made significant strides in improving speed and connectivity with their latest units. While 
they still need to work on their fan noise (it's louder than a MacPro, but softer than the first Drobo I 
tested), for those that need to protect their data, while providing expandability options, the Drobo S 
is a very nice complement to a video editing suite.
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MORE FREE STUFF -- OVER 100 ARTICLES  
POSTED THIS MONTH INTO MY EDITING LIBRARY

One of my goals in writing these newsletters each month is to take key articles from each issue and 
post them to my website. For many years we were able to do that. 

Then, last year, that whole system broke down when my webmaster decided to go off and buy a 
bakery. (She was an excellent webmaster, but an even better baker, so I guess I can't complain... 
much.) So, for many months all those article languished...

Over the last two weeks, I found myself with some spare time, so I went through every newsletter 
issue for the last year, posting relevant articles to my website. Over the course of two weeks, I 
added more than 100 articles!

New releases are posted at the bottom of my home page, but the place you REALLY need to visit is 
the Editing Library. Hundreds and hundreds of articles. All free. All indexed. And all available now. 
Or use the Search page to find exactly what you need. 

Take a look - there's sure to be something in there you will find useful.

[ Go to Top. ] 

THINKING ABOUT STORAGE --  
WHY DON'T HARD DISKS HOLD AS MUCH AS THEY SAY?

Have you ever wondered why a 1 TB drive never has 1 TB of free space? Or why a 500 GB drive 
stores much less than 500 GB?

Well, it isn't your imagination, it's that engineers and marketers use two different numbers - but the 
same words - to measure the storage capacity of a hard drive.

A marketer wants to keep things clear and simple, and make their hard drives seem as big as 
possible. So they define:

�●     A Kilobyte = 1,000 bytes
�●     A Megabyte = 1,000 kilobytes
�●     A Gigabyte = 1,000 megabytes
�●     A Terabyte = 1,000 gigabytes
�●     A Petabyte = 1,000 terabytes

This is all well and good and simple... but wrong.

Because computers don't think using multiple of ten, like we do. Instead, they think using multiples of 
two. (Remember, computers store everything as 1's or 0's, called "bits.")

Surprisingly, 1,000 (which is a power of 10) is not a natural number for a computer. Instead, they 
work with powers of 2. See if this string of numbers looks familiar:

http://www.larryjordan.biz/
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1, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024...

Yup. Each number to the right is the number to its left multiplied by two. So, when a computer 
formats a hard drive, it does so using these power-of-two numbers, which results in storage sizes 
like this:

�●     A Kilobyte = 1,024 bytes
�●     A Megabyte = 1,024 kilobytes
�●     A Gigabyte = 1,024 megabytes
�●     A Terabyte = 1,024 gigabytes
�●     A Petabyte = 1,024 terabytes

So, when you take a drive and format it, about 1% of total storage capacity is used by the drive for 
file directories and other technical stuff. The operating system, as it structures the hard drive for use 
(the process of formatting) also reduces the total available size.

RAIDs also reserve a significant amount of storage for data protection -- roughly 25% of total storage 
capacity.

Finally, you lose storage due to the differences in defining the numbers between the simplicity of 
marketing and the technical realities of how computers actually work.

This is why a 1 TB drive formats to about 931 GB and a 500 GB drive formats to about 465 GB.

For the technically inclined, here's a very nice Wikipedia article discussing disk capacity and access 
speed you may find interesting.

UPDATE -- MARCH 23, 2010 

Robin Harris provides some additional information:

Saw your piece in the newsletter about disk size reporting. Right on - as far as it goes. 
In Snow Leopard Apple fixed the base2 reporting bug by going to base10.

Now Snow Leopard reports the same size that your disk drive says it supports. See 
blogs.zdnet.com/storage/?p=589

Another key point: the percentage difference between reported size and actual size 
keeps growing with capacity; i.e. the disconnect gets worse. [Robin then included a 
table, which I am summarizing here. For instance, using two different units of 
measurement -- 1024 vs. 1000, there was about a 2% difference in storage when total 
storage was measured in Kilobytes, but a 10% difference when storage increased to 
Terabytes.]

The fact is that kilo, mega, giga, tera and peta are formal international standards that 
have been in use for over 200 years. Kilo=1,000 and so on. 

I think the confusion arose because DRAM is measured in the powers of 2 because 
that is how CPUs access it. Since RAM was very expensive and disks were small, 
computer folks didn't differentiate between kilo and kibi (the official power of 2 prefix 
for 1024). 

Apple did all Mac users a favor by fixing this error.

http://en.wikipedia.org/wiki/Hard_disk_drive#Capacity_and_access_speed
http://blogs.zdnet.com/storage/?p=589


Larry replies: Thanks for this clarification, Robin. 

[ Go to Top. ] 

LARRY'S BLOG: RESOLVING A PROBLEM  
WITH THE LATEST PROAPS UPDATE 

This note is taken from my blog. If you haven't read it recently, take a look here. 

Recently, Apple released an update to its ProAps frameworks. These are behind-the-scenes utilities 
that provide shared resources used by all the applications. The new revisions are available via 
Software Update.

In Apple's announcement, they indicated that one of the things they fixed was a series of memory 
leaks, which is something that Soundtrack Pro has suffered from since its initial release.

However, my philosophy is to ALWAYS wait whenever Apple announces a new update - just in case 
the new version does more harm than good. (You can read an article I wrote about upgrading here.) 
So, I didn't install the upgrade until this weekend.

At which point, I immediately began having problems using Soundtrack Pro. After experiencing five 
or six crashes within ten minutes, and sending a crash report to Apple, I did the usual -- Safe Boot, 
Rebuild Permissions, creating new versions of the project file using Save As -- all of which did not 
solve the problem.

What DID solve the problem was trashing Soundtrack Pro's preferences -- something that we have 
not had to do before. 

So, if you find that Soundtrack Pro is becoming unstable:

�●     Save your work and quit Soundtrack Pro
�●     Go to your Home Directory > Library > Preferences folder
�●     Delete com.apple.soundtrackpro.plist
�●     Empty the Trash

Reopen your project in Soundtrack Pro and you should be good to go.

Once I trashed this preference file, Soundtrack has been running reliably for hours.

[ Go to Top. ] 

HOW YOU CONNECT YOUR DRIVE DETERMINES ITS SPEED

In the past we obsessed about the rotational speed of a hard disk, how much cache it had, or even 
the controller chip it used. While these are important, they pale in significance when compared to the 
impact of how you connect your drive to your computer.

A few days ago, I had a lengthy conversation with three folks at Ci Design, who make the 
iStoragePro product line about their family of hard disks and RAIDs. Zin, Cupid, and Katie Khor 

http://www.larryjordan.biz/blog
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joined me for this discussion. (Thanks to Katie Khor for setting this meeting up!) Zin is their sales 
engineer, who did most of the explaining.

As a point of reference, CiDesign has over 27 years experience in storage design. Their latest 
product line is iStoragePro. According to Katie, they focus on creating a full-range of system 
solutions, offering the best in performance, with systems specifically designed for video and audio 
editing on the Mac.

We began our conversation talking about their FireWire drives. And, I must confess, that there's a 
point where one FireWire drive looks a lot like everyone else's drive - especially because they all use 
the same controller chip (Oxford) and same hard drive manufacturers (Hitachi, Seagate, Western 
Digital, Fujitsu). Differentiation is very hard in this industry.

However, our conversation veered into improving performance based upon how the drive is 
connected to your computer. And I found this much more interesting -- and helpful. So I summarized 
our discussion in the bullet points below.

Two starting points to keep in mind:

1. A single hard drive connected inside a recent model MacPro transfers data 
between 75-80 MB/second. If you need faster speeds, you need to harness multiple 
hard drives together into a RAID. 

2. Different video formats require different data transfer rates. For example, DV 
requires 3.75 MB/second. P2 requires about 15 MB/second. RED requires about 38 
MB/second.

NOTES 
For a description of what RAID terms mean, click here. 
For a description of data rates by video format, click here.

http://www.larryjordan.biz/articles/lj_raid-levels.html
http://www.larryjordan.biz/articles/lj_video_data_rates.html


USB. Based on my tests, a single USB-connected drive transfers data between 10-15 MB/second. 
This puts it at the low-end of the speed equation. This protocol works great for slow devices like 
mice and keyboards, but is severely limiting for hard drives. I don't recommend using any USB 
devices for video editing.

FireWire 400. Based on my tests, a single FireWire 400-connected drive transfers data between 20-
25 MB/second. This is because all FireWire drives use a "bridge chip" to convert from the format the 
drive uses, such as EIDE, to the FireWire format. This conversion takes time. Plus, the size of the 
"transfer pipe" provided by FireWire 400 is small. FireWire 400 RAIDS can achieve speeds of up to 
40 MB/second.

FireWire 800. Based on my tests, a single FireWire 800-connected drive transfers data between 45-
55 MB/second. This is fast enough for many video formats, though not enough for extensive multiclip 
work. Also, when you connect both FireWire 400 and 800 devices to the same computer at the same 
time, the FireWire 800 devices slow down to nearly FireWire 400 speeds. This is true of all Macs. 
The only way around this is to install a separate FireWire 800 card in your computer. FireWire 800 
RAIDS can achieve speeds of up to 90 MB/second.

eSATA. Based on my tests, a single eSATA-connected drives transfer data between 70-90 MB/
second. However, eSATA requires an interface card to be plugged into your computer. Many laptops 
and all iMacs don't support these cards. eSATA RAIDS can achieve speeds of up to 400 MB/second.

iSCSI. Based on my tests, iSCSI-connected drives transfer data up to a maximum speed of 100 MB/
second (limited by the speed of your network switches). iSCSI is almost always used for multi-disk 
RAIDs, not single disks. iSCSI connects via an Ethernet cable, but requires a gigabit Ethernet 
connection to achieve these speeds. iSCSI also has the benefit of being able to connect thru a data 
switch, allowing the hard drive to be located in a different room.

FibreChannel. Based on what the iStoragePro engineers told me, 1 port FibreChannel transfers 
about 350 MB/second. 2 port FibreChannel supports transfers at about 700 MB/second. 
FibreChannel systems are always RAIDs, not single disks. The principle benefit to fiber, in addition 
to it's high speed, is the distance you can get between the edit suite and the storage. This can be up 
to hundreds of meters. 

Mini-SAS. Based on what the iStoragePro engineers told me, Mini-SAS-connected RAIDS (and this, 
too, is a RAID-only protocol) can transfer data between 600 - 700 MB/second. The best interface 
card to use is from ATTO. This speed is sufficient for all multiclip work, as well as editing 2k and 4k 
images.

SAS-Extended. Based on what the iStoragePro engineers told me, SAS-Extended-connected 
RAIDs can transfer data between 700 - 800 MB/second. This, too, is fast enough for all current video 
editing. SAS-Extended is a good protocol to use when one RAID is supporting multiple edit suites.

I found this information very helpful in picking the right system for connecting storage systems, 
based upon the video formats I want to be editing.

If you want to learn more about the full product line that iStoragePro offers, please visit here.

Also, for laptop owners, they offer two expansion chassis, which allow you to add cards and storage 
to your laptop. (Currently, the expansion chassis only supports Red Rocket, not AJA or Blackmagic 
Design cards.)

iStoragePro has some very cool stuff.

UPDATE -- MARCH 23, 2009

Ben Balser writes:

http://www.istoragepro.com/
http://www.istoragepro.com/


Question, were you measuring "burst rate" or "sustained rate" for those drives?

Larry replies: Ben, the AJA tool reports average rate. 

[ Go to Top. ] 

CHECK-OUT MY LATEST VIDEO TUTORIALS AND BUNDLES!

I'm working on more tutorials for Final Cut Pro 7. In the meantime, take a 
look at almost 60 video tutorials and bundles. This short, focused video 
training can solve your technical questions and get you up and running 
faster than anything else. 

I have four different bundles - SAVE 30% when compared to buying each 
tutorial separately! 

�●     My Favorite Final Cut Pro Tutorials
�●     Video Compression
�●     Soundtrack Pro Bundle #1
�●     Soundtrack Pro Bundle #2

With more than 60 tutorials available, you can find the complete list of my video tutorials here.

You can find the complete list of my video bundles here -- SAVE 30%!

With all these titles to choose from, and priced at only $4.99 each, there's sure to be at least a 
couple that can help you solve the problems you're having. Each title runs 5-10 minutes and can be 
downloaded instantly. 

More titles coming every month! Take a look and order today! 

[ Go to Top. ] 

AUDIO GEAR FOR THE DIGITAL PRODUCTION BUZZ AT NAB 

As we gear up for our coverage of the NAB 2010 Show, I thought you'd be interested in the gear we 
are using.

This year, like last year, The BuZZ is all audio. Which means I get to leave my make-up kit at home. 
However, that doesn't mean we are just traveling with a single mic.

REMOTE RECORDING

Our traveling reporters and producers are using:

�●     Marantz PMD661 Professional Portable Field Recorder
�●     Shure SM58 microphones 

http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
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Note: Thanks to Carl Gustavson and the people of Marantz for providing the field 
recorders. We used these same models last year and they worked great. We attach 
them to a MacBook Pro via USB to transfer the audio files.

STUDIO RECORDING

Our broadcast studio allows us to interview up to four people at a time. These interviews are 
recorded for our one-hour NAB Show Special Reports every evening.

�●     BeyerDynamic DT190 headset microphones
�●     Aphex 230 Master Voice Channel Processor
�●     Alesis Multimix 8 FireWire mixer
�●     Sennheiser HD202 monitoring headsets
�●     Aphex Headpod 454 headset amp
�●     Presonus HD4 headset amp 

Note: Thanks to Marvin Caesar and the folks at Aphexfor providing some of the 
Aphex gear. (I say some because each year I buy more of it. You need to listen to 
what your voice talent sounds like after the Voice Channel gets done beefing it up!)

All recordings are made on a MacBook Pro laptop running Soundtrack Pro.

STUDIO LIVE BROADCAST 
For the hourly live News Briefs, we use all the gear in the recording studio and add the following:

�●     Aphex 320D Compellor to even out final audio levels 
�●     Alesis 3630 Compressor (for audio fold-back to our phone lines)
�●     Presonus Firebox A/D converter
�●     iMac running QuickTime Broadcaster for the live feed to the streaming server

DATA BACKEND

We are running all our audio and data on a gigabit Ethernet wired network, through a NetGear 16-
port switch, using a MacMini Snow Leopard Server, and recording to a DroboElite; partitioned into 
two volumes with 5 TB of protected storage. 

NOTE: Thanks to Mark Fuccio and Drobo for loaning us the DroboElite.

It is a fascinating collection of gear and I think it creates a great sound for our show. If you are going 
to NAB, stop by Booth SL8826 and take a look at all of it up close.

UPDATE -- MARCH 23, 2009

Mark Schultz writes:

http://www.d-mpro.com/
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Using a handheld cardioid dynamic such as the dependable SM58 for interviews in 
the field is not always the best choice. At a similar price point you could add the EV 
RE-50 to your kit, and move into the smoother sound and friendlier angle of 
acceptance of an omni pattern mic. You can use the 58 in a noisy environment for a 
bit more off-axis rejection, but with the 50, the subject of your interview can lift/lower 
and turn his or her chin and it won't ruin high-frequency response and require loads of 
EQ. Try it, you'll like it.

I see you are using the least expensive gear on the planet as a front end to your rig. I 
guess it makes sense -- lose it, break it, who cares, and it is super lightweight, with 
the minimal specs to spit out a wav file.

Still, It is disheartening to see you recommending an Aphex product that includes a 
"big bottom" knob as well as the dreaded "Aural Exciter." I think it is safe to assume 
that most folks can figure out what to do with a fixed ratio compressor, hard to screw 
that up, but I doubt that rank and file video editors have the ear to understand what 
the parametric EQ does. And, then we have the two huge pitfalls of Big Bottom and 
Aural Exciter waiting to completely change the sound on the way to hard disk. This is 
a disaster waiting to happen, and a terrible recommend for someone who doesn't 
know audio filtering and phase intuitively. 

Throughout the world, in radio studios, in cars, in homes and in sales showrooms, 
excessive indistinct bass is invariably misinterpreted as a good thing. Not everybody 
is James Earl Jones, recorded on a U47 in a dead room. With few exceptions 
recorded voice contains clear evidence of the space it was captured in -- this goes for 
booth records in high-end studios as well as catch-as-catch can stuff from the field. I 
for one can guess the size of the room and the nature of the wall surfaces pretty 
quickly and accurately. In post, you can always sift through the low end and remove 
energy from problematic fundamentals and multiples, and find some intelligent place 
to start hi-passing. Or you can add "BIG BOTTOM"! Yeah baby.

PHASE, and Aural Exciters specifically, may be the only thing people understand 
even less. They are certainly the worst thing since cotton candy. The first bite is great 
and ten minutes later you puke. 

Used incorrectly, the worst recordings since Edison are only a few knob turns away -- 
excessive sibilance, brutal over compression, bad EQ. You know bad color correct 
when you see it, right? It takes some experience to handle it and it's not for amateurs. 

I am certainly not saying you don't know what you are doing. But please be careful not 
to recommend something (even something you get from a friend) to people who don't 
know what they are getting into. Field audio guys wearing headphones and Video 
editors, per se, do NOT hear their audio well enough to judge it, and they often fail to 
understand what to do with filtering tools. Video bays have many hard drives 
humming, speakers at odd angles, doors open to the hallway, producer(s) on the 
phone -- lots of noise to contend with. 

A much smarter setup would be a clean preamp -- for example the John Hardy Twin 
Servo 990, the Millennia HV3C, The Frank Forsell preamps -- try any of them and 
YOU won't believe how good a clean signal with enormous dynamic range can sound. 
EQ it, Compress in post. 

Larry replies: Thanks, Mark. One thing I've learned is that just as there is no one perfect camera, 
there is no one perfect audio setup. I appreciate your thoughts. 
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NAKED MICE NEED NICE RUGS

Yes, it's true. I've learned that some computer mice are being forced to 
slide around on hard, cold tables. Poor mice. However, a solution is 
close at hand.

I've created the latest in mouse-designer fashion -- a warm, toasty, 
mouse-pad covered with over 40 Final Cut Pro keyboard shortcuts.

So, now your mouse gets to keep its red laser nice and warm on these 
cool spring nights, and you get some of the most useful, yet little-
known, keyboard shortcuts all assembled in one easy-to-find place.

This mouse-pad is currently warming the little feet of the mice of some 
of the most famous editors and filmmakers in the world. (No, I can't tell you who, but if I did, you'd be 
impressed.)

Newly redesigned for 2010, this mouse-pad had all the conveniences - a mouse-friendly top surface, 
a grip-the-table-to-death bottom surface, a thick-and-bendy middle, lots of interesting stuff to read, 
and a cute design that will make your mouse feel especially loved.

What's not to like? (You purchased some clothes for yourself recently... isn't it time to do the same 
thing for your mouse?) 

Plus, it has a GREAT low price -- less than $10!  
Support your mouse! Buy your copy today - click here! 
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PASSING THOUGHTS

Short snippets of useful information

FAVORITE iPHONE APPS

I'm interested in learning what iPhone/iPod apps you use in production and post. Send me your 
favorites, along with a FEW lines explaining why and I'll add them to next month.

NEW WEBSITE FOR YOUNG FILMMAKERS

Bob Gillen sent me this:

The website www.thefilmmakerlifestyle.com helps aspiring and experienced 
filmmakers create the movie they’re passionate about. The site offers tips and ideas 
on writing the story, producing it, sharing it with others.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162
mailto:larry@larryjordan.biz?subject=Favorite iPhone App
mailto:larry@larryjordan.biz?subject=Favorite iPhone App
http://www.thefilmmakerlifestyle.com/


NEW ON KENSTONE.NET

New tutorials on KenStone.net:

* Formatting a Hard Drive for the Mac by Ken Stone

"You just purchased a new drive for your Mac, but you need to be sure that it has 
been formatted correctly, here's how."

* Reinstall OS X & Final Cut Studio The Right Way - Part 2, By David A. Saraceno

"This multi-part tutorial suggests a long term strategy designed to produce a problem-
free install, and a quick reinstall if problems should arise again — with the proviso that 
you spend a one time spare afternoon preparing the necessary files and materials. 
The strategy is intended to produce long term results and far less down time."

* Footage Firms Time Lapse Collections, review by Steve Douglas

"Footage Firm's Time Lapse Collections desire to stand out from the pack of the many 
royalty free companies is to provide these collections virtually free of charge in the 
hopes that you will appreciate the quality of their clips and be further inspired to take a 
good look at their other collections of diverse footage."

GETTING QUICKTIME TO PLAY VIDEO AT 4X SPEED

Yariv Newman sent this in:

To get QuickTime to play a movie at 4x speed, without using Final Cut Pro:

1.  Open your video in Quicktime Pro
2.  Select all (Edit > Select all)
3.  Copy (Edit > Copy)
4.  Drag the “Out” marker to halfway along (for twice the playback speed)
5.  Now the key trick. You paste the entire movie into this reduced selection by 

selecting Edit > Add to Selection & Scale
6.  Trim to Selection Edit > Trim to Selection
7.  Export your movie

FIXING SYNC DRIFT IN AUDIO-ONLY CLIPS

Bruce Sharpe has written two blogs about the problems of audio sync drift -- especially when using 
DSLR cameras.

Check them out here and here.

SHOOTING DSLR VIDEO

http://www.kenstone.net/
http://www.kenstone.net/fcp_homepage/formatting_hd_mac_stone.html
http://www.kenstone.net/fcp_homepage/reinstall_osx_fcs_part_2_saraceno.html
http://www.kenstone.net/fcp_homepage/footage_firms_time_lapse_douglas.html
http://brucesharpe.blogspot.com/2009/06/dslr-dual-system-audio-999-solution.html
http://brucesharpe.blogspot.com/2010/02/dslr-sync-drift-in-final-cut-pro.html


King Dexter sent me this reference to shooting DSLR video:

BAD FONTS 

Jon Grimson sent this in:

Larry, I had a real crash problem yesterday with FCP7 and had tried everything. 
Repaired permissions, trash prefs. reinstall FCP, all the typical steps and still no luck. 
I uninstalled 3rd party plug-ins too. Finally remembered many years ago the same 
thing happened and the culprit was...corrupted fonts. I ran verification on font library 
and trashed the 3-4 bad font libraries. That did the trick.

Just wanted to point this out on troubleshooting checklist since I've not seen anybody 
mention this before. But it has been the cause for me twice.

2ND MONITOR PROBLEMS

Jon Grimson then followed up with this:

Just wanted to report back that I believe there is definitely a bug in how FCP handles 
2nd monitor display when it is disconnected and reconnected in a laptop setup. Those 
of you with 2nd monitor display running FCP workspace (not as broadcast reference 
via 3rd party hardware), would likely never notice in desktop setting. 

But people running FCP from laptops who then need to disconnect and go mobile will 
likely NOT be able to restart FCP at all, until they return to office, reconnect to 2nd 
display and manually move desk spaces around. I just tested this and now I can edit 
via laptop only, provided that I saved last in FCP when I had manual re-arranged 
desktop to single monitor, and saved. 

UPDATE -- MARCH 23, 2009

Ben Balser writes:

I and several of my clients run FCP on MacBook Pros, we use a second monitor in 
studio, and none on the road. In checking with them this morning, none of my clients 
experienced this problem, nor have I. I'm curious about his system specs, and how 
he's handling the OS/app. Putting the laptop to sleep, or shutting down? Exiting FCP, 
or leaving it launched? We find FCP very nicely and reliably resets to standard 
window arrangement (cntl+u) when we restart in single screen set up, after exiting 
from a dual screen set up. There's something more going on here.

Larry replies: Thanks for the update, Ben. 

SENDING COMMENTS TO APPLE

Paul Demonte asks:

http://www.photoshopcafe.com/tutorials/magicLantern/magic_lantern.htm


When there are little key problems like this, does Apple normally know about it and 
wait until enough people make a stink about it or is this something [we can tell them 
about].

Larry replies: Paul, thanks for writing!

In FCP is a link, under Final Cut Pro, called Send Apple Feedback. Apple tells me that they read 
these religiously. They don't respond, but they do pay attention.

[ Go to Top. ] 

READER MAIL

GETTING ORGANIZED

Jonathan Hewlett writes:

I have something that has irked me for the longest time (in my short amount of 
experience with FCP) when capturing media off tape. It is a simple thing to dismiss 
initially, but one that obviously can cause headaches later on. What 'best practice' 
measures would you use in logging your clips? I've heard from various people that an 
exotic array of codes for things like reel number and descriptions only using 
underscores and simple names is gospel.

Additionally, should these conventions be carried over when transferring non tape-
based media?

Keep up the amazing work!

Larry replies: Truthfully? It doesn't really matter. Whatever helps you get and stay organized is fine.

For me, though, I like creating a system that spans across projects so that I'm not constantly 
reinventing the wheel.

I use a code for all my tapes - two letters (for the client) two numbers (for the job) and two numbers 
starting with "01" to count the number of tapes shot on a job - thus: "JM02_01" would be "Just-a-
Moment Productions", Job number 2, first tape shot on the job. I've used this for years and it works 
great. Other people have their own system. And that's the key - to have your own system. Final Cut 
prefers Reel IDs that are short. I suggest less than 10 characters.

For shots, I start all B-roll shot names with the letter "B". For talking heads, I start all shot names with 
the last name of the person speaking. (As you may notice, this works great for documentaries and 
corporate videos, which is my main work, and terribly for scripted programs, which I rarely do.)

Figure out a shot naming system that works for you and stick with it. Final Cut doesn't care. It works 
however you want.

The key is to get organized before you start, because trying to get organized after the fact is really 
tough.

Here's an article I wrote that goes into more detail about this - but the ultimate choice is your own.

http://www.larryjordan.biz/articles/lj_archive.html


And here's an article that was contributed by readers of my newsletter:

Hope this helps. And thanks, Jonathan, for all the very kind words in your email, they are much 
appreciated!

[ Go to Top. ] 

MIXING HARD DISKS

Gloria Messer writes:

I currently have two 500-G and one 1-T internal hard drives in my MacPro and would 
like to max out the storage.

1. Can this computer's internal storage be bumped from a max of 4-T storage to 8-T 
storage.

2. Can this computer's internal storage be bumped to 64 cache from 32 cache internal 
storage drives?

3. Can 64 cache and 32 cache drives be mixed on the original 8 Core dual Mac Pro?

Larry replies: Yup, this can be confusing...! (And thanks for writing, it is good to hear from you again!)

Can you increase your internal hard drive storage? Yes, easily. Just change drives. Remember, 
though, to copy your data off your old drive first. And, if you are worried about security, do a secure 
erase to the drive you are going to replace to erase all data before trashing the drive.

The internal cache on a hard drive has no impact on your computer. It is memory the drive uses to 
help make itself faster. So you can easily mix and match drive caches with no problem. In fact, you 
can essentially ignore the internal cache of a drive, as this is something that is optimized by each 
drive maker. You have no control over it.

"64-bit," on the other hand, refers to how the operating system allocates RAM memory IN YOUR 
COMPUTER. Here, things are murkier because applications need to be written to take advantage of 
this increased memory.

Under the old 32-bit system, the most RAM that a single application could access was 4 GB. Under 
the new system the most memory that a single application can access is SO VAST that we don't yet 
have an acronym for it -- it's WAY past Petabytes!!

UPDATE -- MARCH 23, 2009

Ben Balser writes:

Had two clients need to upgrade to 2TB internals for Mac Pros. I used to slap in one 
new drive, used Carbon Copy Cloner to "clone" the system drive. Then swapped it out 
with the original system drive. But I recently invested in the WeibeTech UltraDock, as 
I'm cleaning out old computers (as my father is, also) to bring to a local computer 
recycling facility. We want old data from those old drives, and to wipe them very clean 
(OS X's top security wipe function) of all our personal data. The UltraDock let me 
upgrade my client's drives really fast. CCC'ed the system drive to the new drive, and 
transfer all data to the new drives, all without having to open the Mac Pro. When we 

http://www.larryjordan.biz/articles/lj_filenaming.html


did open it, quickly swap out drives, poof, done! This little gem has paid for itself in 
saved time already. But, it does cost, and folks like me who get a LOT of use out of it 
benefit. If it's a one time upgrade for an end user, swapping out drives physically and 
using CCC is the way to go.

Larry replies: Thanks, Ben. 

[ Go to Top. ] 

CREATING A PAL DVD

Dennis writes:

Enjoyed your PowerUp training in Miami. {I've converted NTSC video, with Graeme 
Nattress' help, to PAL.] Now I need to get all my segments ready for PAL DVD. I need 
to ship them to Switzerland so they can be duplicated. Can you tell me a simple way 
to get my segments into a form for DVD while maintaining high quality? My segments 
cover three days of a conference. Day one is approximately 3 + 1/3 hours, day two is 
4 + 1/3 hours and day three is 3 hours. I assume I'll need to put each day on two 
separate DVDs.

Larry replies: Thanks for writing, Dennis.

It is impossible in an email to tell you everything you need to know to create a DVD using DVD 
Studio Pro. I have a 6-hour training video DVD that explains the whole process.

However, if all you need to know is the setting in Compressor to create a PAL MEG-2 file, that's 
easy.

Once your file has been converted to PAL, import it into Compressor.

In the Settings tab, twirl down Apple, twirl down DVD, and drag the ENTIRE FOLDER for the DVD 
Best Quality that best represents the duration of all the video on one disk of your project.

Given the length of your videos, I would suggest creating a dual-layer disk. This allows you to double 
the amount of storage on each DVD, without decreasing video quality. If you use the DVD Best 
Quality 120 minute setting, you can fit up to four hours of material on one DVD disc.

NOTE: All DVDs are always SD. If you need to create a disc with HD video, you'll 
need to create a Blu-ray Disc, which DVD Studio Pro does not currently support.

However, now things get complex. Because you are delivering a DVD master to replication, and 
because it is not a single-layer disk, they will probably require a CMF-format disc (Cutting Master 
Format) for each layer of your DVD.

You need to verify with your replicators what format they need. Unlike a single-layer disc, you can't 
just send them a DVD or the VIDEO_TS folder. Replicating dual-layer disks require a master for 
each layer of the disc. 

Or, as you suggest, you can split your movie into 2 two-hour segments, put each segment on its own 
disc, and package each seminar as a two-disc set. This would also work, and your compression 
settings would remain the same.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=60
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CREATING MPEG FILES FOR DVD

George Buttle asks:

I was able to create an MPEG 2 file for my HDV movie by using Quicktime 
Conversion.

To make a DVD, I read in one of your articles to go to QuickTime and import as an 
asset into DVD Studio Pro. However, when I try I get a warning that says "Import 
Assets, Incompatible Format. I've always used compressor in the past because by 
choosing Best Quality DVD 90 min. it give me two files, one video and one audio. I put 
them in my Movie folder and they import fine under assets in DVD studio pro, I just 
drag each one to its place on the timeline.

What's wrong?

Larry replies: George, first you need to remember that DVD SP only works with SD video, not HD. 
So, if you are trying to create an HD DVD, you'll need to use FCP 7, or Roxio Toast, or Adobe 
Encore, but not DVD Studio Pro, and create a Blu-ray, or AVCHD, Disc. 

Also, keep in mind that there are dozens of variations of MPEG-2. The files you need to create are 
called "MPEG-2 Elemental Streams" -- and the best way to create them is using Compressor, not 
QuickTime Conversion, because two separate files need to be created -- one for video and one for 
audio.

[ Go to Top. ] 

WHERE DO YOU DRAG WHAT?

Eko Nobel writes:

I just found out from an editor friend of mine, that it's possible to drag file(s) from 
Finder directly to FCP Viewer window or even to the Timeline and that file(s) won't 
appear in the FCP Browser, thus making the project file size smaller and less time to 
open.

Locating the file is still possible using the View > Reveal in Finder command.

My questions are:

1. Is it recommended to do this, because it's going to be difficult if we 
have to go back to data files/folder and captured footage.

2. If someday we have to reopen the project and all the clips in the 
timeline become offline, how we suppose to recapture, without the 
batch list ?

3. How can we export a batch list from this kind of project ?



FYI: I did the off-line cut myself and sent it to a post house to do the on-line. The 
editor open a new project and copied my off line sequence and continued to work by 
starting to drag files ( stills, motion projects, audio etc) from Finder instead of 
importing to Browser

Larry replies: Thanks for writing, Eko.

Yes, you can drag files directly from the Finder into either the Viewer or the Timeline. The problem is 
that if you delete the timeline - or that clip - you loose all references to that clip. Plus, dragging to the 
Timeline does not make your project files significantly smaller.

Not putting a clip into the Browser does not save a lot of space. It is FAR better to drag a clip into the 
Browser, to properly track the clip in Final Cut. 

For me the risk of losing a clip by deleting a sequence, or erasing a clip from the timeline is far 
greater than the time I would save by dragging directly into the Timeline.

You don't need a batch list to recapture, but you do need a list of clips. You can use the list of clips 
in the timeline to recapture, but if that timeline gets lost, so do your clips For all these reasons, I 
really don't recommend dragging clips directly into the Timeline.

[ Go to Top. ] 

IMPORTING TEXT INTO MOTION

Vasan writes:

[In Motion 4] when you open the Inspector > Library > Generator > Text generator 
> File > Import you'll see 4 categories: File, Numbers, Time date, and time code.

Select File and click Apply. 



 
 
This adds a text layer. 

In the Inspector > Generator tab, you will see Browse to choose the file you want to 
import. However, when I click Browse and locate the text file (RTF), the subject file is 
grayed out. 

Larry replies: Vasan, the key to using this is that you need to use a plain text file (TextEdit creates 
these). An RTF file won't work. The generator then displays each line, one after the other. The 
duration each line is displayed on the screen is determined by the length of the effect and the 
settings in the Inspector.

If you want to display one word or one letter at a time, each would need to be on its own line. 

And, you are correct. This is a very fast way to get text to display on the screen.
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DISPLAYING 16:9 VIDEO AS 4:3

Karl Arndt writes:



We capture in HD (16x9) but need to output as SD thru DVD Studio Pro. Is there a 
way to have the video displayed as a 16x9 image inside the SD 4x3 screen. When I 
do the usual SD output it shows as only a 4x3 image.

Larry replies: Sure. I'm assuming you want the video displayed in its entirety, with black bars at the 
top and bottom (letter-boxing). 

If you want to crop the image so that it displays full screen, read this article. 

Otherwise, the easiest way to do this is in DVD Studio Pro.

�●     Edit your HD piece in Final Cut as 16:9 HD. 
�●     Export using File > Export > QuickTime movie, and set settings to Current Setting.
�●     Compress as 16:9 SD using Compressor.
�●     Import the compressed file into DVD SP.

�●     Create a new track and, in the Inspector, change the Display mode of the track to 16:9 
Widescreen.

�●     Drag your video into that track.

Now, your video will automatically display as a full 16:9 image on widescreen TVs, and as letter-
boxed video on 4:3 TVs. In both cases, you'll see the full picture, with nothing cropped.
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CANON DSLR QUESTIONS

Michael writes:

I was looking at getting an HD Pro/Prosumer video camera. I quickly figured out that 
interchangeable lenses on a 1920x1080p capable camera is about a jillion dollars. I 
was wondering what your experience was in using the Canon 5D Mark II as a main 

http://www.larryjordan.biz/articles/lj_resize_16x9.html


video camera. The kind of work that I was looking at doing is things like wedding 
videography, which would require long (about an hour) shots. 

I was wondering, not only about the practicality of the camera for this type of work, but 
also if there were options for storage of video that long. CF cards are not ideal for 
shots that long, so is there a rig that will off-load the video to some sort of Solid-State 
drive or something like that? Curious about your thoughts.

Larry replies: Michael, this is a great question.

Keep in mind that a DSLR camera was designed for capturing still image, not long video recording. It 
isn't designed to emulate what a traditional video camera can do, in terms of output gear or 
continuous recording. 

�●     A DSLR camera is excellent, however, you can't shoot for long periods - 15-20 minutes at 
one time is the max. Then, you need to allow the sensor to cool down. 

�●     You'll need to convert your footage to ProRes before editing, as the camera shoots an H.264 
format which is very hard to edit.

�●     You'll need to spend money for camera accessories to allow you to focus or move the 
camera during shooting.

�●     All your existing lenses will be about 1.6 times closer (i.e. the image will be magnified slightly).
�●     Finally, keep in mind that the audio recorded by the camera is very poor. You'll need 

separate audio gear for recording, which can limit your mobility during a shoot.

Here's an article I wrote that goes into more detail.

Also, take a look at the DSLR blog in Passing Thoughts, earlier in this issue.

UPDATE -- MARCH 23, 2009

Adam Connell writes from Australia:

Great newsletter. One comment of the Canon 5/7d for video. I have not tested other 
SLRs for this: when the canon SLR cams take a still shot, they lift the mirror, and 
capture all pixels at the same time. In the case of video, the mirror is raised 
continuously, but for each frame, or 1/24th or 1/25th or 1/30th a second pixels are 
captures in scanning method of line 1,2,3,4....etc. Obviously your shutter speed for 
video is taken into account but the shutter in these for video is 100% electronic, and 
just affects the time the sensor is on. So, for fast moving objects you might have 
issues. Imagine a strait stick, held vertically moving very fast from one side of the 
frame to the next. The resulting image will look like the stick is horizontal. Similar 
effect as a 'rolling' or electronic simulated shutter. YouTube "hv20 jello effect" you'll se 
what I mean. Canon and Sony use this system on all slrs, and consumer video with 
CMOS/exmor sensors. One of the reasons why I still love my xha1s with a real shutter 
and 3ccds.

Larry replies: Thanks, Adam, for this additional information. 

Bryce Bennet writes:

I thought you would be interested in this PDF file I created last week.

This schematic shows a few simple equipment configurations for using an external 
recorder (like the Marantz PMD661) with a HD-DSLR (like the Canon 5D Mark II). It's 
all based on my particular equipment, but should be fairly straightforward to adapt to 

http://www.larryjordan.biz/articles/lj_red_vs_dslr.html
http://www.larryjordan.biz/assets/nxltr66/Bennett_DSLR_Audio.pdf


other brands/models. 

Yes, the PDM661 is a great recorder - form factor and price point! The rebuilt 
preamps (from Oade.com) really increase its low signal level sensitivity. For my 
location recording I use it with a Rode NTG-3 (short shotgun) and Blimp windshield, 
an AKG C535EB (cardioid), and a lav for my Sony wireless system.

Larry replies: Thanks, Bryce, for the note and the PDF. 

Matt Gottshalk writes:

The Canon 5d Mark II records for 12 minutes and then stops because of the 4 gig file 
system limit on the CF cards.

[While you do need to convert the video to ProRes] with the latest plugin from Canon, 
[which released yesterday] you can do this within FCPro by usinfg the Log and 
Transfer window, just like other tapeless workflows.

[However, lens "zoom-in"] is only true for the Canon 7D, which has a cropped sensor. 
The Canon 5d Mark II is a full frame camera, so an 85mm lens is 85mm.

Larry replies: Matt, thanks for adding this! 

UPDATE -- MARCH 24, 2009

Tim Barksdale adds:

As [Matt mentioned,] the 5D mII is a full frame sensor. Lens are matched with the chip 
at 1:1.

Sensor overheating is not a big issue either. Although, I hesitate to "correct" you on 
this point, as I am an outdoor cameraman.

Larry replies: Thanks, Tim. I'm always happy to correct places where I'm wrong. 
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DECONSTRUCTING SEQUENCES

David Bogard writes:

I want to take a portion of a sequence...say 30 clips... and make a second sequence. 
How do I do this and keep ALL the clips intact (separate video and audio tracts)? 
When I try and copy and paste to the new sequence, it works but I have one long clip 
of audio and video..not the individual items I had in the original sequence. In other 
words, I want the second sequence to appear exactly like the first, but just the 
included clips. Is it possible to do this?

Larry replies: Yes, drag the original sequence from the Browser into the Timeline of the new 
sequence.

When your cursor enters the Timeline window, hold down the Command key. The original sequence 
will automatically deconstruct into its individual clips.



If you just want to bring in a range of a sequence, drag the sequence into the Viewer, set an In and 
an Out, then drag the marked sequence from the Viewer to the Timeline, holding down the 
Command key as your cursor enters the Timeline window.
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WORKING WITH MULTICAM

Wren writes:

I have tried out Multicam editing and its wonderful but this time i am doing a show 
where i want to edit live on the spot with three to five cameras using FCP. I have tried 
and failed, so I researched it on the net for online multicam editing on FCP but all I 
found was offline multicam editing.

Is it possible to do the task on FCP, do i have to use other external hardwares, are 
there any other means to do online editing (multicam) on a mac platform.

Larry replies: QuickTime only supports one in-coming video feed at a time, so, FCP is not able to do 
live multicam switching. Once the video has been captured - i.e. not live - you can link up to 128 
cameras and switch up to 16 video streams at once.

Blackmagic Design has a free utility that allows you to switch two live feeds, but not more. 

However, a new product, introduced earlier this year, is worth investigating: Tools on Air. This may 
meet your needs.

UPDATE -- MARCH 24, 2009

At the request of readers, I did more research on the Blackmagic Design utility I mentioned. It's 
called "On-Air" and is a part of their Intensity cards. According to the Blackmagic site:

Intensity installs the On-Air application which enables Mac Pro users to mix between 
two camera inputs, and capture the resulting video to disk, using two Intensity cards. 
On-Air can record to disk using Apple's uncompressed or compressed codecs. The 
On-Air interface requires a computer monitor with a resolution of 1600 x 1000 pixels.
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SETTING FIELD DOMINANCE

Tim Visterin asks:

Another great feature I am all excited about is the Apple ProRes 4444 codec. 
I was making lower thirds inside After Effects, exported using this codec imported it 
into FCP and boom, no rendering on a DV PAL sequence… A lot of fun!

http://www.blackmagic-design.com/
http://www.toolsonair.com/
http://www.blackmagic-design.com/support/detail.asp?techID=175


I have a small question concerning this. I am working with dv material and [set field 
dominance to] lower fields. My rendering of the lower thirds in After Effects with the 
Apple ProRes 4444 codec has no fields. I am a little bit confused by this. Should I 
[set] my rendered movie files also to lower fields (as my timeline is in DV PAL)?

Larry replies: Tim, ProRes 4444 has fields, but does not require field dominance. Setting the field 
dominance to None is the best choice for this codec. Let Final Cut create the field dominance it 
needs based upon your video codec.
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WHAT IS "ENOUGH" RAM?

Brett Botula asks:

I read in one of your older newsletters (I believe ’08), that you recommend 4 GB RAM 
for FCP, because that is the maximum memory FCP will utilize. I read on the Apple 
site that that 4 GB RAM is especially recommended for use with uncompressed HD 
media. But I also read a moderator on 2-pop who suggested 8 GB RAM for running 
FCP, to leave room for the operating system, and any other open programs to access 
RAM.

Can you round out these views? What’s your thought?

Larry replies: Brett, at this point, FCP only recognizes 4 GB of RAM. Adding more won't help FCP. 
However, adding more allows other applications to access RAM that FCP is not using. So, both the 
moderator and I are correct, but viewing the problem from different angles.

On the MacPro I recently purchased, I installed 8 GB of RAM. However, when FCP is running, it 
uses less than half of that.
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CREATING CLOSED-CAPTION VIDEO

John Stealey asks:

I've been asked to start delivering shows with captioning added on line 21. Our new 
shows start on May 17th with delivery of the first show on May 10th. I've seen article 
about captioning in FCP - they all mention 3rd party software - any suggestions for 
3rd party software I should investigate?

Larry replies: There's only one worth considering: MacCaption. 
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HOW DO YOU CAPTURE A GAME?

http://www.cpcweb.com/index.htm


Connie Lantz asks:

Have you ever captured anything from a VR game like Second Life (I use SnapZ) for 
editing into FCP 6? I'd love to hear what your best recommendations are!

I would assume the animation codec would be best for capture, or maybe Apple pro 
res? Is there a way to smooth out the choppy movement that is inherent in Second 
Life in post production?

Larry replies: Connie, yes, the animation codec, in FCP 6 and earlier, or ProRes, in FCP 7, are the 
best codecs to use. For screen capture, I use both Telestream ScreenFlow and Ambrosia Software 
SnapZ.

However, I don't have a clue about what to use to emulate a game console on the Mac.

UPDATE -- MARCH 23, 2009

Ben Balser writes:

I do films in Second Life. Mechinema I think the kids cal it these days. But I found 
ScreenFlow to be faster and much nicer to work with than SnapzPro X (which I am a 
long time user and fan of). I always save those movie files as DVCPRO-HD, because 
nothing will give you better quality from your computer screen, and it's a smaller file 
size than Pro Res. Animation codec is really overkill for this type of work. It has no 
advantages, the quality is computer screen quality, and that's it. It's been a really fun 
workflow, and a really fun experience. There are tools in Second Life made for in-
world movie making. I can set up a camera tracking path, speed, etc, and have my SL 
actors (we work with live voice for accuracy and speed, "action!") start, well, "acting", 
and the results are amazingly easy animations. Well, easy once you learn the in-world 
tools. I've been just learning the tools and experimenting. But I hope to find a short 
script and do a short film all animated inside Second Life. But I will stand by my 
statement that ScreenFlow and DVCPRO-HD are what I've found to be the easiest, 
quickest workflows that maintain as much quality as I can realistically get. It makes 
editing in FCP a lot faster, too, with less rendering and faster exports. Finally, what 
you get off the screen is what you get off the screen, there's now way to smooth out 
the "lag" in SL in post. I would recommend tweaking the video settings inside your SL 
Viewer app preferences. But that's a long topic for a forum somewhere.

Larry replies: Thanks, Ben. 

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this newsletter. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the 
Digital Production BuZZ every week. In fact, put the free BuZZ player on your website! It's fast, 
simple, and very cool.

�●     Visit our store and buy a mousepad - your mouse deserves the best. 
�●     Or, check out all our current Final Cut Studio tutorials. 

Also, please continue sending me your comments and questions. I love hearing from you and enjoy 

http://www.telestream.net/screen-flow/overview.htm
http://www.ambrosiasw.com/utilities/snapzprox/
http://www.ambrosiasw.com/utilities/snapzprox/
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/articles/syndicate-buzz.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162
http://www.larryjordan.biz/tutorials
mailto:larry@larryjordan.biz?subject=Newsletter comments


the conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 2.0 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to 
sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is 
not sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in 
applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. All 
trademarks are the property of their respective owners and are mentioned here for 
editorial purposes only.

Text copyright 2010 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, without 
specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require prior 
permission. 
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